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1 Introduction

1.1 Text Hawk Text Editor

Thank you for using Text Hawk Text Editor!

Text Hawk Text Editor is a fast, multi-language code and text editor for Windows 95 / 98
/ ME / NT / 2000 / XP / 2003. Use Text Hawk to edit plain text files, programming source
code, HTML and more.

·  Great looking color syntax highlighting (C++, C#, Java, HTML, XML, Perl, PHP, SQL,
and more)
·  Powerful regular expression based search and replace
·  Superior speed and performance
·  Sleek tabbed document interface
·  Configurable auto indentation based on language scoping rules
·  Open and edit documents of any size, limited only by the amount of RAM on your
machine
·  Featured in PC Answers, PC World, Internet Advisor, .net Magazine, and others
·  Free top-notch Technical Support included with purchase
·  All minor version upgrades included with purchase
·  30-day Unconditional 100% Money Back Triple Guarantee
·  Instant Product Key delivery via email
·  Order your copy today! - Only US $27.99, with FREE shipping on all CD-ROM orders!
·  We also have Volume Pricing

http://www.wingenuity.com/awards.html?app=TextHawk&loc=docs
http://www.wingenuity.com/support.html?app=TextHawk&loc=docs
http://www.wingenuity.com/guarantee.html?app=TextHawk&loc=docs
http://www.wingenuity.com/buy-now.html?app=TextHawk&loc=docs
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Experience ease-of-control and power as you effortlessly edit plain text files,
programming source code, and HTML with Text Hawk Text Editor. Text Hawk is the
perfect blend between usability and simplicity because unlike other text editing programs
that can be extremely complex and provide unnecessary features that hinder
productivity, Text Hawk's straightforward user interface gives you the ability to do exactly
what you choose to do without any unwanted interruptions. Essentially, Text Hawk has all
of the features you need as a power-user, but without all of the "bloat" that will get in
the way of your work.

1.2 Ordering Information

Our order form utilizes a secure server (using SSL) to process your transaction, so your
ordering information will be encrypted and kept safe. We also offer a 30-day
unconditional 100% money back Triple Guarantee on all of our products!

Order Text Hawk Text Editor Online:

Click the Buy Now! button to visit our secure online order form, and order your copy of
Text Hawk Text Editor today!  Text Hawk may be ordered through our secure online store
24 hours a day, seven days a week.

(Note: Pricing information is available here.)

Full Version Benefits:

1. Instant Product Key delivery via email.
2. FREE shipping on all CD-ROM orders.
3. All minor version upgrades included with purchase.
4. FREE top-notch Technical Support.
5. 30-day Unconditional 100% Money Back Triple Guarantee.

Additional Payment Methods:

If you prefer, we also provide the ability for you to place your order via Fax, Phone,
Postal Mail or Purchase Order. (Send an email to sales@wingenuity.com for more details.
Please indicate the payment method you would like to use.)

1.3 Customer Support

Our stance on customer support is simple: You, our customer, are the most
important asset to our business! We go all-out to ensure that our technical support is
among the absolute best in the business. Many believe that the greatest cost in running a
successful business is acquiring new customers. That's why you will be treated like gold
by our technical support staff once we have you on board as one of our customers. We

http://www.wingenuity.com/guarantee.html?app=TextHawk&loc=docs
http://www.texthawk.com/?action=buy_now&products_id=2&app=TextHawk&loc=docs
http://www.wingenuity.com/buy-now.html?app=TextHawk&loc=docs
http://www.wingenuity.com/guarantee.html?app=TextHawk&loc=docs
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want you to be our customer for life, so we will always take care of you in a prompt,
friendly and helpful manner.  If you have an issue that needs to be resolved, visit our
Customer Support Center today for a quick resolution!

Customer Support Center:
http://www.wingenuity.com/support.html

Bug Reports:
(Note: Before submitting a bug report, visit the Downloads page to ensure that you are
using the latest released version of Text Hawk Text Editor.)

We strive to ensure that no bugs are released in any of our software products. However,
this is nearly impossible for even the best software producers to achieve. If you should
happen to encounter a bug in any of our software products, we believe it is our
responsibility to fix it. As software consumers ourselves, it absolutely frustrates us to
spend our time and money on software and then find we cannot get it to run properly.
Providing our users with a way to report bugs shows that we are committed to releasing
high quality software products, and allows us to focus on creating the most stable
applications possible.

Please report any issues you are having with our software in our forum listed below.  Be
sure to include the following information:

1. When and how did the problem occur?
2. Can you reproduce the problem?  If yes, please list down the steps.
3. Which version of Text Hawk are you running?  You can get this information from the
About Text Hawk dialog.
4. Which version of Microsoft Windows are you using (98, XP, 2000, 2003, Vista, etc.)?
5. If there were any error messages shown, please include the full text of the error
messages.
6. Any other information which you think may help us identify the cause of this
problem.

Feature Requests:
We cannot guarantee that any requested features will be implemented in future versions
of our software. However, we do evaluate each and every suggestion and do our best to
incorporate those that will be useful to the majority of our user base. If you have a
suggestion for a new feature, please visit the forum below and let us know!

Wingenuity Customer Support Forum:
http://www.wingenuity.com/forum/

Text Hawk Text Editor Forum:
http://www.wingenuity.com/forum/viewforum.php?f=5

1.4 Text Hawk User Forum

We welcome you to visit and participate in our Customer Support Forum.

Wingenuity Customer Support Forum:

http://www.wingenuity.com/support.html?app=TextHawk&loc=docs
http://www.wingenuity.com/downloads.html?app=TextHawk&loc=docs
http://www.wingenuity.com/forum/
http://www.wingenuity.com/forum/viewforum.php?f=5
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http://www.wingenuity.com/forum/

Text Hawk Text Editor Forum:
http://www.wingenuity.com/forum/viewforum.php?f=5

1.5 Contacting Wingenuity, Inc.

Mailing Address:
Wingenuity, Inc.
69947 S River Rd
White Pigeon, MI  49099-9015
USA

Corporate Homepage:
http://www.wingenuity.com/

Text Hawk Text Editor Homepage:
http://www.texthawk.com/

Customer Support Center:
http://www.wingenuity.com/support.html

General Information:
info@wingenuity.com

Sales Email:
sales@wingenuity.com

Sales Phone (Sales related calls only!):
1-269-978-8840
1-866-391-0418 Toll Free

1.6 Reviews and Awards

Our software has been featured in numerous national and international computer
magazines over the years. We are proud to display a sampling of these magazines below.

http://www.wingenuity.com/forum/
http://www.wingenuity.com/forum/viewforum.php?f=5
http://www.wingenuity.com/index.html?app=TextHawk&loc=docs
http://www.texthawk.com/?app=TextHawk&loc=docs
http://www.wingenuity.com/support.html?app=TextHawk&loc=docs
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Over the years our products have been recognized by many leading industry websites.
We have proudly put together some of the awards that our products have received below.



Introduction 9

Copyright © 1999-2006 Wingenuity, Inc.  All Rights Reserved.

5 stars at ZDNet 5 stars at File Transit

5 out of 5 at SoftForAll

5 out of 5 at
BrotherSoft 5 stars at Download 3000

5 stars at Final
Download

5 stars at 8844
Download 5 out of 5 at AcidFiles

5 stars at Ivertech

4 stars at Sofotex

4 stars at GeekFiles

4 stars at ShareUp

1.7 License Agreement (EULA)

CAREFULLY READ THE FOLLOWING LICENSE AGREEMENT.  BY OPENING THE PACKAGE
OR CLICKING ON THE "I ACCEPT THE AGREEMENT" BUTTON, YOU ARE CONSENTING TO
BE BOUND BY AND ARE BECOMING A PARTY TO THIS AGREEMENT.  IF YOU DO NOT
AGREE TO ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT, CLICK THE "I DO
NOT ACCEPT THE AGREEMENT" BUTTON, AND, IF APPLICABLE, IMMEDIATELY RETURN
THIS PRODUCT AND ALL ASSOCIATED PACKAGING AND DOCUMENTATION TO
WINGENUITY, INC. FOR A FULL REFUND.

This End User License Agreement ("Agreement") is a legally binding contract between the
person or entity ("End User") using the Text Hawk Text Editor software ("Software") and
Wingenuity, Inc. ("Licensor").  This Agreement governs your use of the Software and
related explanatory written materials ("Documentation").  "Software" includes any
upgrades, modified versions, updates, additions and copies of the Software.  "You" and
"your" means the person or entity that is being licensed to use the Software or
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Documentation. "We" and "us" means Wingenuity, Inc.

Be sure that you carefully read and fully understand this Agreement.  Wingenuity, Inc. is
only willing to provide you with a license to the Software and Documentation on the
condition that you accept all of the terms and conditions contained in this Agreement.

Your use of the Software or Documentation will constitute your acceptance of, and
agreement to be bound by, all the terms and conditions of this Agreement.  The Software
is "in use" on a computer when it is loaded into temporary memory (RAM) or installed
into the permanent memory of a computer--for example, a hard disk, CD-ROM, DVD-ROM
or other media or storage device.

License Grant

The Software and Documentation are provided to you for use only under the following
terms.  We reserve all rights not expressly granted to you in this Agreement.  You own
the media on which the Software is recorded, but we retain ownership of all copies of the
Software itself.  You assume sole responsibility for the installation, use and results
obtained from use of the Software.

We hereby grant you a limited, nonexclusive, nontransferable license to do only the
following:

· Use the free trial version of the Software for a period of thirty (30) days.  After the trial
period has concluded, you must pay the license fee in order to continue using the
Software.  If you choose not to license the Software by paying the license fee, the
Software must be completely and entirely deleted from all computers in which the
Software has been copied to or installed.

· Install and use the Software on one computer per license at any time for use only in
your own home or place of business.  At no time shall the Software be installed on two
or more computers at the same time unless a separate license is purchased for each
computer on which the Software is to be installed.

· You may either make one copy of the Software solely for backup or archival purposes,
or transfer the Software to a single hard disk, provided you keep the original solely for
backup or archival purposes.  The original and copy of the Software must be kept in
your possession or control, and your installation and use of the Software must not
exceed that which is allowed by this Agreement.  If you receive the first copy of the
Software electronically and a second copy on physical media (e.g., CD-ROM, DVD-ROM,
etc.), the second copy may be used for archival purposes only and may not be
transferred to or used by any other person or entity.

Things You May Not Do

The Software and Documentation are protected by United States copyright laws and
international treaties. You must treat the Software and Documentation like any other
copyrighted material--for example a book.

You may not:

· copy the Documentation,
· copy the Software except to make archival or backup copies as provided above,
· modify, adapt or translate the Software or merge it into another program,
· create derivative works based upon the Software or any part thereof,
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· reverse engineer, disassemble or decompile the Software, make any attempt to
discover the source code of the Software, or otherwise reduce the Software to a human
readable form,

· make the Software accessible via a public network such as the Internet or other file-
sharing services, or

· sublicense, assign, rent, resell, lease or lend any portion of the Software or
Documentation.

Title

We remain the owner of all right, title and interest in the Software and Documentation.
Through your use of the Software, you acquire no ownership interest in the Software or
any component of the Software.  No right, title or interest in or to any trademark, service
mark, logo or trade name of ours is granted to you under this Agreement.  We are the
owner of the copyright for the Software and we reserve all rights related to such
ownership, including the right to duplicate and sell the Software.

Limited Warranty

We warrant that for a period of thirty (30) days after delivery of this copy of the Software
to you:

· the Software will perform in substantial accordance with the Documentation, and
· the physical media on which this copy of the Software is provided to you will be free

from defects in materials and workmanship under normal use.  If the media fails to
conform to this warranty you may, as your sole and exclusive remedy, obtain a
replacement free of charge if you notify us in writing within thirty (30) days after you
acquire the Software.

To the extent permitted by applicable law, THE FOREGOING LIMITED WARRANTY IS IN
LIEU OF ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, AND WE
DISCLAIM ANY AND ALL IMPLIED WARRANTIES OR CONDITIONS, INCLUDING ANY
IMPLIED WARRANTY OF TITLE, NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE, regardless of whether we know or had reason to know of your
particular needs.  No employee, agent, affiliate, dealer or distributor of ours is authorized
to extend or modify this limited warranty, nor to make any additional warranties.

The above warranty does not cover any Software that has been altered or changed in any
way by anyone other than us.  We are not responsible for problems associated with or
caused by incompatible operating systems or equipment, or for problems in the
interaction of the Software with software not furnished by us.  We do not warrant or
promise that the Software is free from bugs or errors, nor do we make any other
promises about the performance, suitability, accuracy, or reliability of the Software, or its
ability to meet your requirements.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO
STATE.

Limited Remedy

Our entire liability and your exclusive remedy shall be:
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· the replacement of any CD-ROM(s) or other media not meeting our Limited Warranty
which is returned to us or to an authorized Dealer or Distributor with a copy of your
receipt, or

· if we or an authorized Dealer or Distributor are unable to deliver a replacement CD-
ROM(s) or other media that is free of defects in materials or workmanship, you may
terminate this Agreement by returning the Software and Documentation and your
money will be refunded.

IN NO EVENT WILL LICENSOR OR THEIR RESPECTIVE DIRECTORS, OFFICERS,
EMPLOYEES, AFFILIATES OR SUBSIDIARIES BE LIABLE TO YOU THE END USER,
REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT,
INCLUDING NEGLIGENCE, FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOST DATA, LOST
PROFITS OR BUSINESS, LOST SAVINGS, BUSINESS INTERRUPTION, LOSS OF USE,
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE OF OR THE
INABILITY TO USE THE SOFTWARE, OR FOR ANY CLAIM OR DEMAND AGAINST YOU BY
ANY OTHER PARTY, EVEN IF LICENSOR, OR THEIR AFFILIATES OR SUBSIDIARIES HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT
APPLY TO YOU.

You agree that we, and our respective subsidiaries and affiliates will not at any time have
any additional liability for any claim, cause of action or injury that you or any other
person may have as a result of: (1) your incorrect usage of the Software or any
documents generated by the Software; (2) connection or toll charges for using the
Software or obtaining updates for the Software; or (3) any fees, costs or expenses arising
out of troubleshooting or technical support for the Software.

You agree that the essential purposes of this Agreement can be fulfilled even with these
limitations on liabilities.  You acknowledge that we would not be able to offer the
Software on an economical basis without these limitations.

Protection and Security

You agree to use your best efforts and to take all reasonable steps to safeguard the
Software to ensure that no unauthorized person or entity shall have access thereto and
that no unauthorized copy, publication, disclosure or distribution in whole or in part, in
any form, shall be made.  You acknowledge that the Software contains valuable
confidential information and trade secrets and that unauthorized use and/or copying is
harmful to us.

Term and Termination

This license agreement takes effect upon your use of the software and remains effective
until terminated.  This Agreement will automatically terminate without notice from us if
you fail to comply with any of its provisions.  You may terminate it at any time by
destroying all copies of the Software and Documentation in your possession.  You agree
on termination of this license to either return to us or destroy all copies of the Software
and Documentation in your possession.

Confidentiality
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The Software contains trade secrets and proprietary knowledge that belong to us and it is
being made available to you in strict confidence.  ANY USE OR DISCLOSURE OF THE
SOFTWARE, OR OF ITS ALGORITHMS, PROTOCOLS OR INTERFACES, OTHER THAN IN
STRICT ACCORDANCE WITH THIS LICENSE AGREEMENT, MAY BE ACTIONABLE AS A
VIOLATION OF OUR TRADE SECRET RIGHTS.

Severability

If any provision of this Agreement is determined to be illegal or unenforceable, such
provision shall be automatically reformed and construed so as to be valid, operative and
enforceable to the maximum extent permitted by law or equity while preserving its
original intent.  The invalidity of any part of this Agreement shall not render the
remainder of this Agreement invalid.

Entire Agreement

This Agreement constitutes the entire and exclusive agreement between you and us
concerning the Software and Documentation, and all prior communications, proposals,
agreements, representations, statements and undertakings, either oral or written, are
hereby expressly canceled and superseded.  No representations or statements of any kind
made by any of our representatives, affiliates or subsidiaries, which are not included in
this agreement, shall be binding on us.

Governing Law; Forum

This Agreement shall be governed by the laws of the State of Michigan, without regard to
conflicts of law provisions.  The exclusive jurisdiction of any dispute arising out of, or
relating to, this Agreement or any dispute arising out of, or relating to, the Software or
Documentation or services provided in connection therewith shall be in the courts located
in the county of Cass, State of Michigan.  If any provision of this Agreement is held by a
court of competent jurisdiction to be invalid or unenforceable to any extent under
applicable law, that provision will be enforced to the maximum extent permissible and
the remaining provisions of this Agreement will remain in full force and effect.

Waiver

No waiver of any provision or condition herein shall be valid unless in writing and signed
by you and one of our authorized representatives.  Our failure to insist upon or enforce
strict performance of any provision of this Agreement or any right shall not be construed
as a waiver of any such provision or right.

Export Provisions

You agree that the Software will not be shipped, transferred or exported into any country
or used in any manner prohibited by the United States Export Administration Act or any
other export laws, restrictions or regulations.

Acknowledgment

BY USING THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ALL TERMS AND
CONDITIONS CONTAINED HEREIN.
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1.8 Distribution Permission

Wingenuity, Inc. allows and encourages all web sites, on-line services, CD-ROM vendors,
and end-users to freely distribute the trial version of Text Hawk Text Editor. If you wish
to distribute this software, you may obtain the most recent trial version from
http://www.texthawk.com. Licensed versions may not be distributed.

Acknowledgements:
Portions Copyright 1997-2000 Barry Allyn. All rights reserved.

1.9 Check for New Version

From the Help menu...

...click "Check for New Version..." to launch your default browser which checks to see if
you have the latest version of Text Hawk Text Editor installed.

http://www.texthawk.com/?app=TextHawk&loc=docs
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2 Installation

2.1 System Requirements

Text Hawk Text Editor requires a 32-bit Windows platform.

Such compatible platforms include:

·  Windows Vista
·  Windows Server 2003
·  Windows XP
·  Windows 2000
·  Windows 98
·  Windows 98 Second Edition (SE)
·  Windows Millennium Edition (ME)
·  Windows NT 4.0
·  Windows 95

Additional Requirements:

· 16MB RAM (64MB or more recommended)
· 8MB hard disk space
· VGA Color Monitor (minimum 256 colors)
· Keyboard
· Mouse

2.2 Installing Text Hawk

Installing from CD-ROM:
1. Insert the CD-ROM into your CD-ROM drive.
2. Run the TextHawkSetup.exe program:

3. If you have auto run enabled, the TextHawkSetup.exe program will start
automatically when you insert the CD-ROM.

4. If you do not have auto run enabled (or the TextHawkSetup.exe program does
not start automatically):

5. Double-click My Computer from your Desktop.
6. Click on the CD-ROM drive icon.
7. Double-click the TextHawkSetup.exe program icon.

8. Follow the on-screen instructions as the setup program guides you through the
installation process.

Installing from download:
1. Download TextHawkSetup.exe to your Desktop (or any other folder of your choice).
2. Double-click the TextHawkSetup.exe program icon on your Desktop.
3. Follow the on-screen instructions as the setup program guides you through the

installation process.
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2.3 Enter Product Key

Once you have purchased Text Hawk Text Editor, your personal Product Key will be sent
to you via email.  Follow the steps below for the easiest way to unlock your copy of Text
Hawk:

1. Highlight the Registration Information section of this email (including the dashed
lines) and copy it to your clipboard by pressing Ctrl+C on your keyboard.

2. Run Text Hawk and choose "Enter Product Key..." from the Help menu.

The registration information should automatically be filled in for you (though you may
have to click the Grab Clipboard button).  Click OK to finish the process.  If this process
fails, you may need to manually type the registration information into the Enter Product
Key dialog.  Please make sure to enter the information EXACTLY as indicated to you in
the registration email.  You might want to manually copy and paste the Registration
Information into the Enter Product Key dialog.  Your Product Key is unique to you, and is
associated with the order you placed when you purchased Text Hawk Text Editor.

If successful, you will see the "Thank you for purchasing Text Hawk Text Editor!"
message. If you see the "You have provided an invalid name or product key." message
instead, carefully check over the registration information ensuring that it was entered by
following the previous steps. If you still have problems unlocking your copy of Text Hawk
Text Editor, please contact us via email for help. (Include both the original Order Number
and your unique Product Key located in the registration email.)

2.4 Upgrading from a previous version

It is safe (and recommended) that you simply install the latest version of Text Hawk Text
Editor on top of any previous version already installed.  All settings and configuration
data will be carried over to the newer version automatically.  Before upgrading, however,
please ensure that you have a product key for the newer version, or your unlocked copy
of the older version will turn into a trial copy of the newer version.

2.5 Uninstalling Text Hawk

Text Hawk Text Editor may be uninstalled in one of two ways:

·  Click the Uninstall Text Hawk icon in the Start Menu.  (Start | Programs | Text Hawk
Text Editor | Uninstall Text Hawk Text Editor)

·  Open the Windows Control Panel and double click on Add or Remove Programs.  Then
choose Text Hawk Text Editor from the list of applications to uninstall.





Part

III



Text Hawk Documentation20

Copyright © 1999-2006 Wingenuity, Inc.  All Rights Reserved.

3 Using Text Hawk

3.1 Main Window

Text Hawk Text Editor is great for editing plain text files as well as for coding in C/C++,
Java, JavaScript, C#, Basic, VBScript, PHP, HTML, XML, Delphi, Cobol, Assembly, LATEX,
CSS, ASP, JSP, Cold Fusion, Pascal, Perl, Python as well as SQL scripts or any other text
based programming language. Text Hawk also makes a great editor for editing system
files such as batch files, INI files, log files, CSV files, and various other types of script
files and Make files.

3.2 General Toolbar

The following buttons are part of Text Hawk's General Toolbar (from left to right):

1. New - <Ctrl+N> - Creates a new document ready for editing within Text Hawk's
main window .

2. Open - <Ctrl+O> - Opens an existing document for editing within Text Hawk's main
window. (See Opening Files  for other ways to open files with Text Hawk Text

20

32
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Editor.)
3. Save - <Ctrl+S> - Saves any changes that have been made to the active document.
4. Print - <Ctrl+P> - Launches the Print dialog to send the active document to any of

the system defined printers.
5. Cut - <Ctrl+X> - Cuts the current selection from the active document and places it

onto the clipboard. This menu item is disabled until a selection is made to the active
document.

6. Copy - <Ctrl+C> - Copies the current select from the active document onto the
clipboard. This menu item is disabled until a selection is made to the active
document.

7. Paste - <Ctrl+V> - Pastes the current contents of the clipboard into the active
document.

8. Find - <Ctrl+F> - Launches the Find dialog. Click here for more details.
9. Undo - <Ctrl+Z> - Undoes the previous edit action(s). This button is disabled when

there are no valid actions to undo.
10. Redo - <Ctrl+Y> - Redoes the previously undone edit action(s). It is only possible to

redo if one or more undo actions have already taken place. This button is disabled
when there are no valid actions to redo.

11. Repeat Command - <Ctrl+R> - Launches the Set Repeat Count dialog. (See
Repeating Commands  for detailed information.)

12. Go To Line - <Ctrl+G> - Launches the Go To Line dialog. (See Go To Line  for
detailed information.)

13. Help - <F1> - Launches this help file using your default browser.
14. Enter Product Key - Launches Text Hawk's Enter Product Key  dialog. This button

is only visible on the trial version of Text Hawk Text Editor.  (Note: This button
disappears when a valid product key has been entered and accepted.)

15. Buy Text Hawk Now! - Launches Text Hawk's online order form.  (Note: This button
disappears when a valid product key has been entered and accepted.)

3.3 Menus

3.3.1 Main Menu

The File menu has the following sub-menus:

1. New - <Ctrl+N> - Creates a new document ready for editing within Text Hawk's
main IDE.

2. Open... - <Ctrl+O> - Opens an existing document for editing within Text Hawk's
main IDE. (See Opening Files  for other ways to open files with Text Hawk Text
Editor.)

3. Close - <Ctrl+W> - Closes the active document.
4. Save - <Ctrl+S> - Saves any changes that have been made to the active document.
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5. Save As... - Launches the Save As dialog in order to create a copy of the active
document with a different name.

6. Print... - <Ctrl+P> - Launches the Print dialog to send the active document to any of
the system defined printers.

7. Exit - Closes Text Hawk's main IDE along with any documents that are currently
open. Text Hawk will notify you if there are any unsaved documents and allow you to
save them or discard your changes.

The Edit menu has the following sub-menus:

1. Undo -  <Ctrl+Z> - Undoes the previous edit action(s). This menu option is disabled
when there are no valid actions to undo.

2. Redo -  <Ctrl+Y> - Redoes the previously undone edit action(s). It is only possible
to redo if one or more undo actions have already taken place. This menu option is
disabled when there are no valid actions to redo.

3. Cut -  <Ctrl+X> - Cuts the current selection from the active document and places it
onto the clipboard. This menu item is disabled until a selection is made to the active
document.

4. Copy -  <Ctrl+C> - Copies the current select from the active document onto the
clipboard. This menu item is disabled until a selection is made to the active
document.

5. Paste -  <Ctrl+V> - Pastes the current contents of the clipboard into the active
document.

6. Delete Selection -  <Del> - Deletes the selected text of the active document. This
menu option is disabled when there is no text selected.

7. Select All - <Ctrl+A> - Selects all text of the active document.
8. Find... - <Ctrl+F> - Launches the Find dialog. Click here  for more details.
9. Replace... - <Ctrl+H> - Launches the Find and Replace dialog. Click here  for

more details.

The View menu has the following sub-menus:

1. General Toolbar - Toggles the General Toolbar's  visibility. This toolbar is on by
default.

2. Status Bar - Toggles the status bar's visibility. The status bar is on by default.
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The Tools menu has the following sub-menus:

1. Repeat Command... - <Ctrl+R> - Launches the Set Repeat Count dialog. (See
Repeating Commands  for detailed information.)

2. Go To Line... - <Ctrl+G> - Launches the Go To Line dialog. (See Go To Line  for
detailed information.)

3. Toggle Bookmark - <Ctrl+F2> - Toggles the bookmark display on and off for the
current line. (NOTE: The Show Left Margin  option must be enabled for the
bookmarks to be visible.)

4. Go To Next Bookmark - <F2> - Moves the cursor forward to the next line of the
active document that has a bookmark set. If there are no other bookmarks before the
end of the document, the cursor will wrap to the beginning of the file and be placed
on the first line that has a bookmark set.

5. Go To Previous Bookmark - <F2> - Moves the cursor backward to the previous line
of the active document that has a bookmark set. If there are no other bookmarks
before the beginning of the document, the cursor will wrap to the end of the file and
be placed on the last line that has a bookmark set.

6. Clear All Bookmarks - <Shift+Ctrl+F2> - Turns off all bookmarks on all lines for
the active document.

7. Show Whitespace - This option toggles the display of all whitespace characters on
and off.

8. Options... - Choose this option if you would like to configure the way Text Hawk Text
Editor operates. (See Application Options  for detailed information.)

The Window menu has the following sub-menus:

1. New Window - <Ctrl+N> - Creates a new document ready for editing within Text
Hawk's main window .

2. < File Name(s) > - Activates the selected document. This sub-menu is only
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available when at least one document is currently open.
3. More Windows... - Launches the Select Window dialog to activate any of the

currently open documents. This sub-menu is only available when ten or more
documents are currently open.

The Help menu has the following sub-menus:

1. Contents... -  <F1> - Launches Text Hawk's help file.
2. Buy Text Hawk Now!... - Launches Text Hawk's Buy Text Hawk Now  dialog. This

sub-menu is only visible on the trial version of Text Hawk Text Editor.
3. Enter Product Key... - Launches Text Hawk's Enter Product Key  dialog. This sub-

menu is only visible on the trial version of Text Hawk Text Editor.
4. Check for New Version... - Launches your default browser to check for the latest

version.
5. About Text Hawk Text Editor... - Launches the About Text Hawk dialog.  This

dialog contains contact information, and links to the Text Hawk homepage and email
address.

The Buy Now! menu launches Text Hawk's online order form.
(Note: This menu disappears when a valid product key has been entered and accepted.)

3.3.2 Context Menu

The Context menu has the following sub-menus:
(Note: This menu is activated by right-clicking the main editing window of Text Hawk
Text Editor.)

1. Cut - <Ctrl+X> - Cuts the current selection from the active document and places it
onto the clipboard. This menu item is disabled until a selection is made to the active

5
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document.
2. Copy - <Ctrl+C> - Copies the current select from the active document onto the

clipboard. This menu item is disabled until a selection is made to the active
document.

3. Paste - <Ctrl+V> - Pastes the current contents of the clipboard into the active
document.

4. Select All - <Ctrl+A> - Selects all text of the active document.
5. Delete Selection - <Del> - Deletes the selected text of the active document. This

menu option is disabled when there is no text selected.
6. Find... - <Ctrl+F> - Launches the Find dialog. Click here  for more details.
7. Replace... - <Ctrl+H> - Launches the Find and Replace dialog. Click here  for

more details.
8. Undo - <Ctrl+Z> - Undoes the previous edit action(s). This menu option is disabled

when there are no valid actions to undo.
9. Redo - <Ctrl+Y> - Redoes the previously undone edit action(s). It is only possible to

redo if one or more undo actions have already taken place. This menu option is
disabled when there are no valid actions to redo.

3.4 Application Options

3.4.1 General

1. Show left margin - This option displays a margin on the left side of the document
viewing area. (NOTE: This option must be enabled in order for bookmarks to be
visible.) This option is enabled by default.

2. Show line numbers - This option allows for the viewing of sequential line
numbering. This option is disabled by default.

3. Show tooltip on scroll - This option displays a tooltip of the current line while
scrolling up or down on a long document. This option is enabled by default.

4. Show splash screen - This option displays Text Hawk's splash screen each time it is
launched. This option is disabled by default.

5. Allow column selection - This option allows for the highlighting and manipulation
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of text columns. To select columns of text, <Ctrl>+drag the cursor when no text is
currently highlighted. You can then manipulate this block of highlighted text (cut,
copy, paste, etc). This option is enabled by default.

6. Allow drag and drop - This option allows for the dragging and dropping of
highlighted text. Dragging highlighted text moves it to the desired location, while
<Ctrl>+dragging highlighted text copies it. You can even drag and drop text to and
from other application windows that support OLE Text Drag and Drop. This option is
enabled by default.  (NOTE: This option only applies to dragging and dropping
highlighted text, and does not affect File Drag and Drop .)

7. Use smooth scrolling - This option forces Text Hawk Text Editor to scroll the
document contents smoothly. This option is enabled by default. (NOTE: When editing
extremely large text files, it is much less CPU intensive while scrolling if this option is
disabled.)

8. Show horizontal scrollbar - This option displays or hides the horizontal scrollbar.
This option is enabled by default.

9. Show vertical scrollbar - This option displays or hides the vertical scrollbar. This
option is enabled by default.

10. Allow horizontal splitting - This option displays or hides the horizontal splitter bar.
This option is enabled by default.

11. Allow vertical splitting - This option displays or hides the vertical splitter bar. This
option is enabled by default.

12. Confirm before exit - This option prompts you before exiting Text Hawk, to ensure
that you intended to do so. This option is disabled by default.

3.4.2 Font

To select Text Hawk Text Editor's document editing font, click the "..." button in the
upper right corner of this tab. This launches the font selection dialog, and displays only
the fixed pitch fonts available on your system to choose from.

1. Font Name - The default font name is Courier New.
2. Size - The default font size is 10.
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(NOTE: This font setting is only provided so that you may adjust Text Hawk's document
editing font to your liking. It is not indented to provide advanced font manipulation, thus
only a single font may be used at any given time).

3.4.3 Tabs

Tab Settings:

1. Tab size - This option configures how many spaces a tab character is worth. This
option is set to 4 by default.

2. Replace tabs with spaces - When this option is enabled, each tab character that is
typed will be converted to the number of spaces dictated by the tab size. This option
is disabled by default.

Auto Indentation:

1. Mirror previous line's indentation - This option uses the previous line's
indentation as a guide for the next line's indentation. For example if the beginning of
the current line contains three tabs, when the Enter key is pressed, the newly created
line will contain three tabs as well (regardless of any language scoping issues). This
is the default selection for auto indentation.

2. Language scoping dictates indentation - This option indents each newly created
line based on the scope nesting of the language being used.

3. Off - This option turns the auto indentation feature off completely. Only manual tabs
will be created.
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3.4.4 Language

1. Enable color syntax highlighting - This option enables the text of your code to be
colored based on the syntax of the language in use. Multiple documents of different
languages may be opened at the same time, and as long as this setting is enabled,
they will each highlight based on their own individual language. This option is
enabled by default.

2. Fix case for language keywords - This option changes the case of keywords that
you type based on the specification of the language in use. For example, C/C++ is a
case sensitive language so when you type "INT" and press enter, Text Hawk Text
Editor will convert this to "int" for you on the fly. This option is disabled by default.

3. Default language - This option dictates which language will be used for new
documents. The language set by this option is overridden (based on the file extension
used) when the file is initially saved. For example, if the default language is set to
C/C++ when you create a new document, the color syntax highlighting of this
document will be based on C/C++. When you save the document, however, the
language used will be dictated by the file's extension. So if you save it as a Java file,
the color syntax highlighting will be based on Java. Likewise, when you open a file
from disk the language used will be determined by the file's extension, not the
Default Language. The default language selection defaults to "[NONE]", which means
that all new documents created will contain no color syntax highlighting until you set
this option.
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3.5 Child Dialogs

3.5.1 Find Text

Text Hawk Text Editor gives you the ability to search for text within the active document.
Type a search term into the "What" box and click Find to determine if it exists in the
active document. If the search term exists Text Hawk will highlight it for you, and you
may then press the F3 key to locate additional occurrences of the search term in the
active document.

Mark All - The Mark All button sets a bookmark in the active document for each
occurrence of the search text.  (NOTE: The Show Left Margin  option must be enabled
for the bookmarks to be visible.)

The following options are available:

1. Match whole word only - If this option is selected, Text Hawk Text Editor only finds
whole word search terms that match the text as used in the "What" box.

2. Match case - If this option is selected, Text Hawk searches for search terms with the
same case as used in the "What" box.

3. Regular expression - If this option is selected, the search term will be treated as a
standard Gnu regular expression. Following is brief introduction to these rules:

      Wildcards:
1. ? - Matches any single character. ( Example: ?at matches whole words bat and

cat but does not match slat )
2. + - Matches one or more of anything.
3. * - Matches zero or more of anything.

      Sets:
1. Search sets must be enclosed in square brackets.
2. Character ranges must be specified with a dash. ( Example: b[a-i][a-i] matches

big and bad but does not match bug )
      Other:

1. Escape characters. ( Example: \t will match true tab characters )
2. Expressions can be nested into sub-expressions with parentheses.
3. Sub-expressions may be logically ORed together with the vertical bar: |

4.  Direction - This option determines the direction from the cursor in which the search
will begin. It also dictates which direction in which subsequent searches will take place.
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3.5.2 Replace Text

Text Hawk Text Editor also gives you the ability to search and replace text within the
active document. Type a search term into the "Find" box and click Find Next to determine
if it exists in the active document. If the search term exists, Text Hawk will highlight it for
you. You may then continue to click the Find Next button to cycle through all occurrences
of this search term. You may also choose to click Replace to replace the currently
selected occurrence of the search term with the text in the "Replace with" box. Clicking
on the Replace All button will replace all instances of the "Find" text with the "Replace
with" text.

The following options are available:

1. Match whole word only - If this option is selected, Text Hawk Text Editor only finds
whole word search terms that match the text as used in the "Find" box.

2. Match case - If this option is selected, Text Hawk searches for search terms with the
same case as used in the "Find" box.

3. Regular expression - If this option is selected, the search term will be treated as a
standard Gnu regular expression. Following is brief introduction to these rules:

      Wildcards:
1. ? - Matches any single character. ( Example: ?at matches whole words bat and

cat but does not match slat )
2. + - Matches one or more of anything.
3. * - Matches zero or more of anything.

      Sets:
1. Search sets must be enclosed in square brackets.
2. Character ranges must be specified with a dash. ( Example: b[a-i][a-i] matches

big and bad but does not match bug )
      Other:

1. Escape characters. ( Example: \t will match true tab characters )
2. Expressions can be nested into sub-expressions with parentheses.
3. Sub-expressions may be logically ORed together with the vertical bar: |

4. Preserve case - This option preserves the case used in the "Find" box when replacing
text with the contents of the "Replace with" box. ( Example: Find - ABCDabcd, Replace
with - wxyzwxyz. This will cause all ABCDabcd to be replaced with WXYZwxyz even
though
Replace with has wxyzwxyz.
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5. Replace in:
1. Selection: - This option is only enabled when there is a section of text

highlighted before invoking the Find and Replace dialog. With this option
selected, text will only be replaced within that selection of text.

2. Entire buffer: - With this option selected, text will be replaced throughout the
entire contents of the active document.

3.5.3 Go To Line

Use this dialog to jump to the line number specified. The Go To Line dialog can be
activated in one of three ways:

1. Keyboard Shortcut - <Ctrl+G>.
2. Menu - Select Go To Line... from the Tools menu.
3. General Toolbar - Click the Go To Line button.

3.5.4 Repeating Commands

Use this dialog to set the number of times the next command should be repeated. Once
you click OK Text Hawk Text Editor will wait for the next edit command, and will repeat it
the number of times specified on this dialog. The Set Repeat Count dialog can be
activated in one of three ways:

1. Keyboard Shortcut - <Ctrl+R>.
2. Menu - Select Repeat Command... from the Tools menu.
3. General Toolbar - Click the Repeat Command button.

Below is an example of how to use the Repeat Command tool to duplicate a block of text:

1. Copy - Copy a block of text to the clipboard.  (NOTE: This text does not have to be



Text Hawk Documentation32

Copyright © 1999-2006 Wingenuity, Inc.  All Rights Reserved.

copied from a document open in Text Hawk Text Editor. It works equally well if you
copy the text from another source.)

2. Set the repeat count - Launch the Set Repeat Count dialog and choose the number
of times you would like the block to appear.

3. Paste - Paste the block of text into the document. The paste command will be
repeated the number of times specified in the previous step.

3.6 Supported File Types

The following file types are supported for editing:
(NOTE: An asterisk (*) designates that color syntax highlighting is supported.)

· ASP Files
· Assembly Files
· BASIC Files*
· Batch Files
· C/C++ Files*
· C# Files
· Cobol Files
· Cold Fusion Files
· CSS Files
· CSV Files
· Delphi Files*
· HTML Files*
· INI Files
· Java Files*
· JavaScript Files*
· JSP Files
· LATEX Files
· Log Files
· Make Files
· Pascal Files*
· Perl Files*
· PHP Files*
· Python Files
· SQL Script Files*
· Text (ASCII) Files
· UNIX / Linux Script Files
· VBScript Files*
· XML Files*
· ( ... and all other file types that are text-based )

3.7 Opening Files

With Text Hawk Text Editor, there are several ways to open the documents you wish to
edit.
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1. File Drag and Drop - Simply drag files from Window Explorer and drop them onto
Text Hawk's document tabs to open them. You may drag one file at a time, or as
many as you wish.

2. Send To - Just right click a single file (or a group of files) from Windows Explorer,
and choose Send To --> Text Hawk Text Editor. (NOTE: You must enable the Send To
option while installing Text Hawk.)

3. Within Text Hawk itself - The other standard ways of opening files include the File-
->Open menu, the Open button on the toolbar, and the <Ctrl+O> keyboard shortcut.
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4 Revision History

What's new in this version?  (Version 5)

· Added color syntax highlighting for 12 different programming and scripting languages
· Integrated powerful regular expression searching and replacing
· Added a new and improved tabbed document interface
· Improved overall speed and performance
· Column-based selections are now possible
· Added configurable auto indentation based on language scoping rules
· Line numbering is now optional
· Added the ability to insert Document Bookmarks
· Font used for editing is now customizable
· Added toggle for displaying whitespace
· Tab size is now customizable
· Added Repeat Command tool
· Added auto-fix for case of language keywords
· Added Go To Line dialog
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5 Privacy Policy

(Note: This document is subject to change without notice.  Please view the Privacy Policy
online for the latest version of this document.)

Your privacy is very important to us. Wingenuity, Inc. will never share, sell, lend or
otherwise make any customer information available to third parties without your consent,
unless it is required by law for us to do so.

We may occasionally contact you regarding product updates, bug fixes, or other product
related information.

Cookies:
Our website makes use of anonymous cookies to track the way our website is used. A
cookie is a small amount of data that is sent from our web server to your browser. This
small amount of data is then stored on your hard drive so that it may be accessed later
for informational purposes. That information can then be used to: track your progress
when placing an order, help ensure affiliate effectiveness, analyze the way our site is
being used, etc. No personally identifiable information is stored in our cookies.

Information Collection and Usage:
We gather general website usage information (such as the number of times our products
have been downloaded, the number of times specific pages have been visited, etc). Also,
when you visit our website or order our products, we may ask that you provide us with
certain types of personal information (such as your name, mailing address and email
address). We use this information, for example, to fulfill and/or ship orders placed from
our website.

External Links:
Our website may contain links to third-party websites. We have no control over any
content, policies or practices employed by these websites. We suggest that you read any
policies applicable to the site you are visiting as, for example, this privacy policy only
applies to our website.

Website Security:
This site has security measures in place to protect the loss, misuse and alteration of the
information under our control.

Forums:
Should you choose to become a member of our forums (to gain access to our online
technical support), you will need to provide us with a username/password and a valid
email address. This information will only be used to grant you access to the forums, and
will not be shared with any third parties. Any information posted to our online forums
becomes public information, which means that you should exercise good judgment while
posting information on the forum pages. We are not responsible for any information
posted to our forums.

Changes to this Privacy Policy:
Wingenuity, Inc. reserves the right to amend this policy from time to time without
advance notice. Any amended terms will be posted clearly on this website.

Acceptance of Terms:

http://www.wingenuity.com/privacy.html?app=TextHawk&loc=docs
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By accessing this website (and using our software products and services) you are
agreeing to the practices regarding the information collection, and its associated use, as
described in this policy.
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